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C h a p t e r  1 4

Text and
Mtext
Annotation
Annotation is a very important component of any document. On any given drawing,

annotation can range from a single word to a column of paragraphed text. Being able

to efficiently create and edit text directly affects your productivity. In this chapter, you

learn how to do the following:

� Determine your text height

� Define a text style

� Use single-line text

� Create and modify mtext

� Perform a spelling check

� Look at additional text options

� Perform text property modification

� Invoke Quick Text mode, mapping fonts, and the Windows clipboard
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Choosing the Correct Text Height
The hardest part of adding text is deciding on the correct text height for the scale for

which the drawing is set up. Use Tables 14.1 and 14.2 to help you determine the correct

text height. To use these tables, go to the row associated with your drawing scale, and

then move along the row to the column associated with the height you want your text

to have on your plot.

Table 14.1 Text Heights for Architectural Scales
Drawing Scale Plotted Text Heights

3/32" 1/8" 3/16" 1/4" 3/8"

1/16"=1' 18" 24" 36" 48" 72"

3/32"=1' 12" 16" 24" 32" 48"

1/8"=1' 9" 12" 18" 24" 36"

3/16"=1' 6" 8" 12" 16" 24"

1/4"=1' 4.5" 6" 9" 12" 18"

1/2"=1' 2.25" 3" 4.5" 6" 9"

Table 14.2 Text Heights for Decimal Scales*
Drawing Scale Plotted Text Heights

3/32" 1/8" 3/16" 1/4" 3/8"

1:10 0.9375 1.25 1.875 2.5 3.75

1:20 1.8750 2.50 3.750 5.0 7.5

1:50 4.6875 6.25 9.375 12.5 18.75

1:100 9.3750 12.50 18.750 25.0 37.5

*All values in basic drafting units
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I N S I D E R T I P

The simple equation to determine the size to make your text is the plotted scale
multiplied by the desired text height. For example, at the scale 1/4”=1’-0”, divide 12”
by 1/4”, or 12.0/0.25, which equals 48.0.Then multiply by the desired text height,
1/8”, or 48.0×0.125, which equals 6.0.This calculation can be done directly in
AutoCAD using the CAL command >> Expression: 12/(1/4)*0.125.
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Choosing a Text Style
The appearance of text is controlled through a drawing named object know as a text

style. The default text style supplied in a blank drawing is STANDARD, whereas in other

template drawings, several text styles can be predefined for you. Although the default

text style STANDARD is available, most users will generally want to customize the

appearance. You use the STYLE command to create a new text style definition prior to

creating new text objects.

Defining Text Styles
You can define as many text styles as you need in a drawing. You can access the STYLE

command by choosing Text Style from the Format menu. Figure 14.1 shows the Text

Style dialog box. The various settings within the Text Style dialog box are explained in

more detail later in the chapter.

Chapter 14 Text and Mtext Annotation

Figure 14.1 The Text Style dialog box.

To create a new style, click the New button. It uses the current style as a prototype for

the new one. If the current style is not the style you want to begin with, select the desired

style from the list of existing styles (thereby making it the current style).

After clicking the New button, you type a name in the New Text Style dialog box. A

duplicate style is then created from the selected style and assigned the name you pro-

vided. To rename an existing style, select the style from the list of existing styles, click

the Rename button, and enter a new name. To delete an existing style, highlight the

name from the list of existing styles and click the Delete button. The STANDARD text

style cannot be deleted or renamed. The current text style cannot be deleted either.
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I N S I D E R C A U T I O N

The STANDARD text style cannot be renamed using the STYLE command but can be
renamed using the RENAME command. However, doing so has been known to cause
AutoCAD instability—it is suggested you avoid renaming it.

Text styles are stored in the drawing in which they are defined. If you want multiple styles

to be available in a new drawing immediately, define the styles in your template drawings.

If you want to import a style from another drawing, use AutoCAD’s DesignCenter. For

more information on importing text styles into the current drawing, refer to Chapter 12,

“Applications for DesignCenter.”

When defining a new style or modifying an existing style, you must choose a font file, a

text height, a width factor, an oblique angle, and the special effects you want enabled.

Choosing these settings and previewing the results of these settings are covered in the

following sections.

Choosing a Font and Style
The font file is the file that contains the information that determines the look of each

character. Table 14.3 lists the various types of font files supplied with AutoCAD.

Table 14.3 Font Files Types
Filename Extension Font Type

SHX AutoCAD’s native fonts, known as an SHX font file.

TTF TrueType font file or TTF.

TrueType fonts are supplied with Windows or other Windows applications.
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I N S I D E R N O T E

When a text object is created, the style with which it is created is stored as a property of
the object.A text style can be deleted only if no existing text objects reference the style.

I N S I D E R N O T E

An SHX file may also be a Big Font file. Big Fonts are used to support text shapes
that are non-ASCII. For instance, you can create symbols to use as text in a Big Font
file without affecting a text style’s normal ASCII characters. Big Fonts are also used
to support other languages, such as providing the Kanji character set.
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You can use PostScript files in AutoCAD. To do so, you must first use the COMPILE

command to compile the PostScript (PFB) font file into a shape (SHX) file.

AutoCAD supports TrueType font families, which means that for some TrueType fonts,

you can choose a font style such as regular, italic, bold, or bold italic. Note that not all

TrueType fonts have more than the regular style defined.

Two system variables affect the plotting of text using TrueType fonts: TEXTFILL and

TEXTQLTY. When TEXTFILL is disabled, the characters are plotted in outline form only. If

TEXTFILL is enabled, the characters are filled in. The value of TEXTQLTY affects the

smoothness of the characters at plot time. The value of TEXTQLTY can be set from 0 to

100, with the default value set to 50. The higher the value, the better the resolution of the

characters, but the longer it takes to process the drawing for plotting. Both system vari-

ables can be typed at the command prompt and then set to the desired value.

Chapter 14 Text and Mtext Annotation

I N S I D E R T I P

Using the simplest-shaped characters minimizes the drawing size and speeds up
opening and working with the drawing file. Simpler-shaped characters are those that
use very few elements, or line segments, to define a character’s shape.The charac-
ters in the Simplex and Romans SHX files are quite simple in appearance and are
similar to the Leroy characters used previously in manual drafting. Some shape files
contain the alphabet of foreign languages, such as GREEKS.SHX, or even symbols,
such as SYMUSIC.SHX.

After you change the font file associated with an existing style and apply the change, all

text that has already been created with the modified style is updated to reflect the change.

I N S I D E R N O T E

The density of the fill of a given text font, including solid fill TrueType fonts, can
increase the size of a plot file dramatically. It has no effect on the drawing file size
itself, however.

Setting a Height
Also found in the Font area of the Text Style dialog box is the text height setting. The

default height of 0 dictates that the user is allowed to set the text height at the time the

text is created. A height other than 0 forces the text height for that particular style to that

height. The style is then referred to as a fixed height style, and any text command height

prompts are suppressed.
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I N S I D E R N O T E

Changing the text height setting of an existing style does not affect the appearance of

existing text objects.

Previewing the Text Style Settings
The character Preview area enables you to view a sample of the selected style and the

results of changing the various settings. To view your own sample text, type your sample

text in the text edit box and click the Preview button.

Specifying Special Effects
The Effects section of the Text Style dialog box contains the Upside Down, Backwards,

Vertical, Width Factor, and Oblique Angle settings. These settings are covered in detail in

the following sections.

Upside Down, Backwards, and Vertical Text
In the Effects area, you can enable the Upside Down, Backwards, and Vertical settings.

See Figure 14.2 for an example of how these settings affect the appearance of text.

402 Part IV Annotating, Dimensioning, and Plotting

Figure 14.2 The effects of Upside Down, Backwards, and Vertical text settings.

Although the Upside Down and Backwards options work with all font files, the
Vertical setting works only with specific SHX files.
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Unlike the font file setting, the Upside Down and Backwards settings for an existing style

can be changed without affecting text that has already been typed in that style; the text

is not automatically updated to reflect setting changes. Changing the Vertical setting,

however, does affect existing text objects, so you may want to create a new style before

changing the Vertical setting.

Chapter 14 Text and Mtext Annotation

I N S I D E R T I P

The Backwards option is useful if you want to plot text on the back side of a trans-
parent plot sheet so that the text is readable when viewed from the front.

The Vertical option is useful when you need to add text in a column format like a
schedule heading.

Setting a Width Factor
The Width Factor determines the width of the characters. A factor of 1 results in the

characters being displayed with the width as defined in the chosen font file. A factor

greater than 1 results in wider characters; a factor less than 1 results in thinner charac-

ters. Figure 14.3 illustrates the effects of using different width factors. All three text

objects were added with the same text height.

Figure 14.3 The effects of the Width Factor setting on text objects.

I N S I D E R T I P

Adding text with a width factor that is less than 1 may make it easier to squeeze
text into an already crowded drawing while still keeping the text readable.
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Setting an Oblique Angle
The Oblique Angle setting affects the slant of the characters. It is often used to add italic

text when the characters in the font file being used are not naturally italic. Unlike the

text rotation angle, the oblique angle of 0 refers to a vertical direction (see Figure 14.4).

A positive angle value makes the letters lean to the right, and a negative value makes the

letters lean to the left.

Figure 14.4 The effects of the Oblique Angle setting on text objects.

Now you have an understanding of the STYLE command and how to define a new text

style and adjust the properties. Next, you learn about the various types of text objects.

Single-Line Text
A single line of text can consist of a single character, a word, or a complete sentence. The

simplest form of text is created by using the TEXT command. To insert a single line of

text, use the Draw pull-down menu and choose Text, Single Line Text. The initial

prompt displayed in the command window presents a few options:

Specify start point of text or [Justify/Style]

I N S I D E R N O T E

A non-dynamic version of the TEXT command is available by typing –TEXT.This other
command version can be used to create text by using AutoLISP or scripts.

I N S I D E R T I P

When you enter text, you can take advantage of the command history to repeat
previously entered text.You use the up and down arrow keys to scroll through the
command history.

Part IV Annotating, Dimensioning, and Plotting
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The default option is to specify the lower-left corner, otherwise known as the start point,

of the new line of text. After picking the start point, you are prompted to supply the

height (unless the height is defined in the style being used), the rotation angle of the text,

and the actual text to be created. As you type the text, it is displayed on your drawing. If

you make a typographical error, you can use the Backspace key to delete the error and

retype the text. You signify the end of the line of text by pressing the Enter key, at which

point you can begin a new line of text immediately below the text object just created. To

stop adding lines of text, press the Enter key without typing any new text. You can also

relocate the next line of text by picking a point with the cursor. You may skip a line of

text by pressing the spacebar and then pressing Enter. Note that this does not create a text

object for the blank line.

Chapter 14 Text and Mtext Annotation

I N S I D E R T I P

The spacing between successive lines of text is fixed by the font used for the text
style. In many cases, this spacing is at a factor of approximately 1.666 of the text
height. Each line of text created with the TEXT command is a separate object and
can be moved independently.

If, after you end the TEXT command, you want to add an additional line of text below

the last line created, you can easily do so by issuing the command again and pressing the

Enter key instead of picking a new start point. TEXT then adds the new line of text right

below the last one, using the style, height, and rotation angle of the previous line. You

can also do other activities, such as drawing lines, erasing objects, and placing dimen-

sions, and still continue with a new line of text below the last one.

I N S I D E R T I P

To help you spot the last line of text created, that line is highlighted when you begin
TEXT.The highlighting, however, may not be apparent if the text is too small or off
the screen.

Typing the text you want to create is the easy part. It is also important to know how to

format the text according to your needs. The following sections discuss how to choose

the correct text height, justification, and text style.
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Choosing a Justification
The default option of TEXT is to specify the left endpoint, or the start point, of the line

of text. Specifying the Justify option at the initial prompt displays the following prompt:

Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]

Figure 14.5 shows the various TEXT justification options and their corresponding 

locations.

406 Part IV Annotating, Dimensioning, and Plotting

Figure 14.5 Justification points for a standard piece of text.

Unlike the justification options illustrated in Figure 14.5, the Align and Fit options

require you to define two points.

Use the Align option when you want to specify the left and right endpoints of the text

and do not care about the resulting height. The text height is automatically set to make

the text fit between the specified points. Also, the angle from the first point to the 

second point is used as the rotation angle of the text.

Use the Fit option when you want to specify the left and right endpoints and the height

of the text. To make the text fit between the specified points, AutoCAD varies the width

of the text characters. Therefore, you may end up with skinny-looking characters on one

line and very fat-looking characters on the next.

I N S I D E R T I P

You can enter the required text justification option when the TEXT command prompts
for the start point, which eliminates the need for first selecting the Justify option.
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407

When the text is initially added with one of the alternate justification options specified,

it is displayed left-justified, as if the default justification were being used. When the TEXT

command ends, the text is relocated and set with the correct justification.

Chapter 14 Text and Mtext Annotation

You can snap to the justification point of a text object by using the Insert object
snap mode.

Editing Single-Line Text
Two commands are of particular use for editing existing text: DDEDIT and PROPERTIES.

DDEDIT is easier to use than PROPERTIES when all you want to do is change the text

string. PROPERTIES is more powerful than DDEDIT in that it displays the Properties 

dialog box, which enables you to change all the properties of the selected text.

Using DDEDIT
From the Modify menu, click Object, choose Text, Edit to issue the DDEDIT command.

Select the text object to be changed, and the Edit Text dialog box appears, displaying the

selected text (see Figure 14.6).

Figure 14.6 The Edit Text dialog box.

I N S I D E R T I P

If you double-click on a text object, it opens up in the appropriate text editor—a
handy thing to use when you need edit your text objects.

Initially, the entire line of text is highlighted and is replaced by whatever you type. If you

want to edit a specific portion of the text, position the cursor at the desired point in the text

and pick it. You also use the Insert, Delete, and Backspace keys to add and delete characters.

If you want to replace a portion of the text displayed in the Edit Text dialog box, high-

light the portion to be replaced and then type the new text.
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Using Special Formatting Codes and Symbols
You can do a limited amount of formatting with the TEXT command. For instance, you

can add a line under or above the text simply by adding the codes %%u (for underlining)

and %%o (for overlining) to the text as you enter it. The codes act as toggle switches; the

first time you include the code in a text object, it turns that effect on and is applied to

the successive text characters. The second time you enter the code in the same text object,

the effect is turned off. If you do not enter the code a second time in the text object, the

effect is continued to the end of the text object but is not continued to the next text

object. For example, to add the text shown in Figure 14.7, you would type this line of

text: %%uUnderlining%%u and %%oOverlining%%o can be used separately or

%%o%%utogether.
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Figure 14.7 Using underline and overline formatting codes.

Using Properties
Choose Properties from the Standard toolbar or the Modify pull-down menu to launch

the Properties palette, as shown in Figure 14.8. The Properties palette enables you to

change the text contents, style, justification point, and various settings that control the

appearance of the text object.

Figure 14.8 The Properties palette.
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As you can see, the Properties palette provides an edit area for changing the text value,

although it is generally used only for manipulating the format of text objects. The next

section delves into the mainstream annotation type, MTEXT.

Multiline Text
The TEXT command can be used to add multiple lines of text, yet each text object is

added as a separate object. Often, you want to add multiple lines of text as a single object.

In such cases, you need the MTEXT command, issued by choosing Multiline Text from the

Draw toolbar or from the Text submenu of the Draw pull-down menu.

After you start the MTEXT command, you are prompted to select the first corner point of

a window. This window is used to determine the point where the mtext object will exist.

By default, the mtext object is created with a top-left justification. If you want, you can

change the justification type to one of eight others: TC (Top Center), TR (Top Right),

ML (Middle Left), MC (Middle Center), MR (Middle Right), BL (Bottom Left), BC

(Bottom Center), or BR (Bottom Right). These justification types are similar to those

available with the TEXT command (refer to Figure 14.5), except that they apply to the

whole mtext object and not just a single line of text.

You then indicate the desired width of the mtext window. A width of zero disables the

automatic word wrap feature of the Text Formatting dialog box. With that setting, you

must press the Enter key when you want to start a new line of text.

Several other command line options appear, but many of these are easier to set through

the Text Formatting dialog box (see Figure 14.9). The Text Formatting interface is

divided into two parts. The bottom part is the editor, and the top part controls the 

properties, which are described in detail in later sections.

Chapter 14 Text and Mtext Annotation

Figure 14.9 The Text Formatting dialog box.
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Creating Mtext Objects
Previous versions of the Text Formatting editor were somewhat crowded with icons and

tabs. It was revamped in AutoCAD 2004 and reduced to the bare essentials needed to

produce text. The plethora of options still exists, however, and the options are now

located in the right-click shortcut menu. As shown in Figure 14.10, there are many

options related to creating mtext that can be taken advantage of.

410 Part IV Annotating, Dimensioning, and Plotting

I N S I D E R N O T E

Several options, Line spacing and Rotation, are still only available at the command
line before the dialog box appears.

Figure 14.10 The right-click shortcut menu has many features, as well as several submenus.

In the following exercise, you learn about the various aspects of creating and editing

mtext objects.

Exercise 14.1 Using MTEXT to Create Paragraphs of Text

1. Open the drawing 14EX01.dwg from the accompanying CD. It contains several

predefined text styles that we will utilize.

2. Start the MTEXT command by choosing the Multiline Text tool from the Draw

toolbar. AutoCAD reports at the command line:

Current text style:  “Standard”  Text height:  0.2000
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This indicates which text style is current and what height will be active in the

editing dialog.

3. At the Specify first corner prompt, go ahead and pick the upper-left corner

mark.

Chapter 14 Text and Mtext Annotation

I N S I D E R T I P

The little text sample attached to the cursor is adjustable. Normally it reads abc, but you
can change the MTJIGSTRING system variable to whatever you would like it to read.

After you pick the first corner, you then are permitted to make changes to the

current mtext settings, as shown in the prompt:

Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/Width]

4. Similar in nature to the TEXT command, you adjust the size of the text, its justifi-

cation, and other properties prior to entering the editor. We pass on this now; go

ahead and specify the opposite corner by using the lower-right corner mark. The

Text Formatting dialog then appears.

I N S I D E R T I P

The AutoCAPS item on the right-click menu permits you to leave Caps Lock off, yet
type text in the editor window in uppercase letters.

5. Within the editor window, type the following note:
6”x1/2” CONT. EMBED PLATE WITH 3/4” DIA. x 5” LONG H.S. @ 24” 
➥O.C. (STAGGER LOCATIONS OF STUDS WITH BRIDGING ANCHORS)

Depending on how your system is configured, as you typed the note, you may

have gotten the AutoStack Properties dialog, as shown in Figure 14.11. This dia-

log enables you to control how your fractions should appear and enables you to

“set it and forget it.” Select your preference; the examples used here are similar

to the Architectural style of drafting.
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The other drop-down list to the right of the Style drop-down is Font. It is not
related to the Style control; in reality, it is similar to a dimension override, enabling
specific portions of the mtext object to use another font. It should only be used if
you must have a differing font embedded within the rest of the text.

Figure 14.11 The AutoStack Properties dialog box is where you can tweak your fraction’s
appearances.
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I N S I D E R T I P

If you need to adjust the AutoStack Properties dialog settings and have instructed it to
not show again, you can still get to it. Highlight an existing stacked fraction and, using
the right-click shortcut menu, choose Properties.Then on the Stack Properties dialog
box, as shown in Figure 14.12, choose the AutoStack button to gain access once again.

Figure 14.12 The Stack Properties dialog box enables custom stacking styles to be applied
to an individual fraction.

6. After typing the note, it is obvious that the current font is rather unappealing.

Use the Style drop-down list and select Romans. Instantly, the text within the

editor changes appearance to that of the Romans font.
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Your multiline text is now complete. Press the OK button to close the Text Format-

ting dialog box. You should now have a text object that looks like Figure 14.13.

Leave this drawing open for the following exercise.

Figure 14.13 A typical mtext object.

This short exercise exemplifies the ease of use of the Text Formatting interface. Although

the control area of the dialog is available, facilitating immediate changes to text properties,

productivity can be gained by presetting the various properties prior to actually showing

the interface. Some of the controls are also available through toolbars and system variables.

Customizing for Text Styles
AutoCAD 2005 comes with two toolbars for creating and manipulating text objects.

Shown in Figure 14.14, the Styles toolbar contains a drop-down list for setting the cur-

rent text style. Also shown in Figure 14.14 is the Text toolbar, which has tools to create

single and multiline text as well as other editing features.

Figure 14.14 Toolbars available to control, create, and edit text and mtext objects.

System variables affect the creation of text objects and their preset properties (see Table

14.4). These can be used in your customization methods to speed setting up your 

environment.

Chapter 14 Text and Mtext Annotation
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Table 14.4 Text Formatting System Variables
System Variable Description

TEXTSIZE Sets the text height for all new text-based objects created.

TEXTSTYLE Sets the current text style.

After you begin to customize your AutoCAD environment, you can take advantage of

ways to set to specific properties and start the MTEXT command in one click. The follow-

ing menu macro is an example:

^C^C_.-style;romans;romans.shx;;0.8;;;;;

When executed, this creates the text style Romans, assigning ROMANS.SHX to it 

and leaving all properties except for width set to 0 or off. The width factor is set to 0.8,

providing a slightly narrower text style:

^C^C(setvar “TEXTSIZE” (* (getvar “DIMSCALE”) (getvar “DIMTXT”)))

This short AutoLISP code first retrieves the current DIMSCALE value, which is used to

control how large the parts in a dimension object appear. The code then gets the current

dimension style text height, multiplies these two together, and applies that size to the sys-

tem variable TEXTSIZE. Click this button, and the next time you create text, it will match

your current dimension style appearance.

Customization such as this can be placed within your Custom menu, on a Tool palette,

or on a toolbar, or it can even be coded as small AutoLISP programs. As you develop 

the formatting specifics, you will learn where best to house them for the greatest 

effectiveness.

Editing Multiline Text
Very often, you will have to change the content in a mtext object. Early versions of

AutoCAD required the user to erase the text and re-create it. Luckily for you, editing isn’t

that bad now. Just as easily as you create the content, you can later edit it as needed.

414 Part IV Annotating, Dimensioning, and Plotting
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Exercise 14.2 Editing Mtext Objects

1. Continue from the previous exercise. If needed you can open the drawing

14EX02.dwg from the accompanying CD. It contains a single mtext object and

some reference polylines.

2. Double-click on the mtext object, utilizing AutoCAD’s double-click editing fea-

ture. The MTEDIT command starts, and the Text Formatting dialog box appears.

3. Locate on the top line CONT. and highlight the period. Then type INUOUS,

eliminating the abbreviation. You probably noticed that a few words moved

down to the next line. That’s a key feature of mtext—word wrapping.

4. Now highlight the word PLATE. Using the right-click shortcut menu, choose

Symbol and select Property Line. The word PLATE is then replaced with a new

AutoCAD 2005 PL symbol.

Chapter 14 Text and Mtext Annotation
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As you work with the MTEDIT dialog, you may notice it moves around to located
itself over the text being edited. If this functionality is bothersome, you can use the
MTEXTFIXED system variable to eliminate that activity.When turned on (1), the dia-
log enables you to place it on-screen wherever you want, and it displays there until
moved.Additionally, turning this system variable on makes the editor background
match the display background color.When off, the dialog background is translucent
to show objects behind it.

5. Next, locate the word DIA. and highlight it. Use the right-click shortcut menu

and select Symbol. At the top of the Symbol submenu, select Diameter %%c. It

doesn’t look like much now; you will have to wait until the command ends.

6. Locate the O.C. and highlight it. Again use the right-click shortcut menu and

select Change Case. Select lower case to change the case for the ON CENTER

reference.

I N S I D E R T I P

You can also use Ctrl+Shift+U or Ctrl+Shift+L to change selected text case to
upper or lower, respectively.

7. Click the OK button to close the editor. You can also click outside of the editing

window to end the command.
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You have edited the mtext object. You should also notice that the %%c now 

represents a diameter (Ø) symbol, as shown in Figure 14.15.

Leave this drawing open for the following exercise.
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Figure 14.15 The edited mtext object with new text content and symbols.

There are a few specialty character combinations used by AutoCAD, as described in the

following section.

Specialty AutoCAD Symbols
You can add symbols that are in the font file but that are not on the keyboard. Table 14.5

shows several formatting codes and the resulting symbols.

Table 14.5 Additional Formatting Codes
Formatting Code Symbol Meaning

%%c Ø Diameter

%%d ° Degree

%%p ± Plus/minus

The codes are not case-sensitive. In addition to the codes in Table 14.5, you can enter the

code %%nnn, where nnn is a three-digit integer, to add any character in a font file.

AutoCAD 2005 comes with a series of new symbols. Shown previously in Figure 14.10,

these new symbols require that you use new AutoCAD 2005 versions of SIMPLEX and

ROMANS files as well new ISOCP and ISOCT series files.
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In the previous exercise, if you change the font file to Arial, for example, the PL sym-
bol becomes undefined and represents itself as small square. Due to this characteris-
tic, caution should be taken when using new AutoCAD 2005 symbols with drawings
that will be used by others who may not be on the same release.

A much easier way to add a symbol is to use the Windows Character Map program. To

use the Character Map program in place of the %%nnn code, simply start the Character

Map program by selecting Other on the Symbols submenu and select the TrueType font

file you have specified in the current text style. Then select the character you want to add

and copy it to the clipboard. You can then paste the character into the text you are typing.
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Not all font files contain the same characters, which is why it is important that the
font file you choose to copy from in the Character Map program is the same font
file specified in the text style you are drawing with in AutoCAD.What the Character
Map program actually copies when you copy a character to the clipboard is the
character’s position number in the font chart.When you paste that character into
AutoCAD, the character corresponding to the position number recorded in the clip-
board is drawn.Therefore, if you are using a different font file in AutoCAD, you may
end up with a different character altogether.

MTEDIT Right-Click Shortcut Features
As you have discovered, there are many options available on the MTEDIT right-click

shortcut menu. The following sections discuss some of these features in detail.

Insert Field
Fields are a new AutoCAD 2005 feature for embedding dynamic text values within text-

type objects such as mtext. Refer to Chapter 21, “Using Fields and Tables,” for more

information.

Indents and Tabs
With the addition of indentation and tab stops, using AutoCAD as a limited word

processor is easier than before.
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As shown in Figure 14.16, the highlighted row of text in these notes is utilizing both fea-

tures. It has an tab stop to push the 2. text over. It has another tab stop to push start of

the REDUCTION text over. It then has an indent for all lines after the first one, helping it

line up with the previous line.
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There is a dialog specifically for setting indents and tabs.Accessed from the Text
Formatting right-click shortcut menu, choose Indents and Tabs, showing the Indents
and Tab dialog.

Figure 14.16 Indents and tab stops in mtext aid in alignment.

I N S I D E R T I P

You can adjust your indents within the editor window; just grab the appropriate indent
marker and slide as desired.The top marker sets the first line indent; the bottom
marker sets the indent for the rest of the paragraph.You can also place new tab stops
by clicking on the ruler. Remove tabs by clicking on one and dragging it off the ruler.
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Justification
After you are in the Text Formatting dialog, you can still change text justification if

needed. The Justification submenu contains all available alignments for mtext objects.

Just click the placement type you need, and the content of the editor instantly updates.

Find and Replace
Use the Find and Replace feature to search for a specific combination of characters and

even to replace the text found with different text. If the Match Case setting is enabled,

AutoCAD finds only text that exactly matches the case of the search string. If the Whole

Word setting is enabled, AutoCAD finds only words that fully match the search string;

otherwise, other words that contain the search string are located. After you specify the

settings you want, use the Find button to start the search.

Stack and Unstack
The Stack/Unstack option is an slick feature in AutoCAD 2005 that is used to stack or

unstack selected text. For example, you can designate selected text to be stacked by using

special characters between the characters you want stacked. The text to the left of the

character is placed on top of the text to the right of the character. To unstack stacked text,

select it and then click the Unstack option.

AutoCAD 2005 provides for three stacked text types based on which of the following

characters is used:

� Carat (^). Converts selected text to left-justified tolerance-style stacking.

� Forward slash (/). Converts selected text to center-justified text separated by a

horizontal bar.

� Pound sign (#). Converts selected text to a fraction-style stack separated by a

diagonal bar.

You can edit stacked text and change the stack type, its alignment, or the size of stacked

text in the Stack Properties dialog box, shown previously in Figure 14.12.

Import Text
If you have text in an existing TXT or RTF file, you can use the Import Text button to

import the file into the editor, and then you can edit the text as needed. Click this option

and then simply locate the text file to bring in. The content is read and placed within the

editor at the current cursor location.
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Background Mask
A great new feature in AutoCAD 2005 is text masking. Basically, this provides the capa-

bility have a colored background property applied to your mtext object. In addition,

this mask can display the background of your screen—essentially blanking out other

drawing content that may exist within the mtext object boundary.

Setting the Bold, Italic, and Underline Text Properties
The Bold and Italic buttons enable you to bold or italicize the text, but only if the 

chosen font file is a TrueType font. You can use the Underline button to underline any

selected text, regardless of the font file used. All three buttons act as toggles, and you 

can turn their properties on or off by simply selecting the desired text and clicking the

appropriate button.
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If you are using an SHX-based font, you can use the oblique angle to achieve the
appearance of italics.

Color Settings
The Text Color list enables you to set the color for selected text. You can set the color to

ByLayer, ByBlock, one of AutoCAD’s 255 colors, or a True Color or Color Book setting.

Secondary Editing of Mtext Objects
You can use grips to move or change the width of the mtext object. When you select the

grip point that corresponds to the justification point, you can move the mtext object. If

you select any other grip point, you stretch the width of the mtext object. The following

exercise shows the ease with which other mtext properties can be changed.

I N S I D E R T I P

A new object snap opportunity exists in AutoCAD 2005. Now the corners (same
locations as the grips) can be targeted using the Node osnap mode. Primarily used
to align the corners or edges with other objects, this feature can be controlled
through the OSNAPNODELEGACY system variable.When set to 0, it is active; when set
to 1,AutoCAD does not provide nodes for an mtext object.
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Exercise 14.3 Modifying Mtext Objects

1. Continue from the previous exercise. If needed you can open the drawing

14EX03.dwg from the accompanying CD. It contains a single mtext object and

two reference polylines made in the previous exercise.

2. Double-click on the mtext object, invoking the MTEDIT command.

3. Press Enter to create a new line. Then move the cursor back up to the top line and

type NOTE:. Then select that new text and then press the U (underline) button.

Notice that the Bold font property is unavailable. The current style’s font does

not include a bold component.

4. Highlight (if needed) the NOTE: text and, using the Font drop-down list, select

Arial. It is near the top of the list. Choosing it changes just the selected text to

that font.

5. Now the Bond font property is available. Select it to make the NOTE: bold.

6. Select the NOTE: text (if needed). In the size list, type in 0.25, making the text

noticeably bigger than the rest of the text.

7. Again, with the NOTE: text selected, use the Color drop-down list and pick red.

Now the added text is bigger and more distinctive.

8. Use the right-click shortcut menu and select Background Mask. The Background

Mask dialog box is presented. Turn on the Use background mask option, and

leave the other settings as shown in Figure 14.17. Close the dialog. Press OK to

close the Text Formatting dialog box.
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Figure 14.17 You can set an mtext background color with the new Background Mask feature.

You didn’t see a visible change to the background of the mtext object. This is

partly due to the fact that the background color and the mask are identical. To

truly appreciate this feature, you need something to hide.

9. Draw a line from one corner mark to the other mark.

Again, no change. This is because the last object drawn is on top of previous

items drawn. But that is easily corrected.
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10. Select the mtext object so that its grips are activated. Then use the right-click

shortcut menu and choose the Draw Order submenu, Bring to Front option.

Instantly, the line is now hidden by the area of the mtext object, plus a little bit

more. Notice in Figure 14.18 that the corner mark is also being clipped. This

clipping is handled by the border offset factor, as shown in Figure 14.17.

You can close this drawing without saving.
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Figure 14.18 The revised mtext object, hiding all objects behind it.

I N S I D E R N O T E

It should be noted that the entire mtext boundary box is the space that gets filled
with the mask.As the bottom line content shows, even though the text doesn’t
extend very far, the boundary masks that area.Also note that the Draw Order com-
mand is crucial to implementing this feature well.A given mtext object can mask all
other things, including other mtext objects and dimensions that are below it in the
draw order.

I N S I D E R T I P

Even geometry that is masked is still there, selectable and available.
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Line Spacing Controls
Shown in Figure 14.19 is a portion of the Properties palette with the mtext object from

the previous exercise selected. Most text properties can now be managed through the

right-click shortcut menu found within the Text Formatting dialog box. A few exceptions

exist, including the line spacing properties.
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Figure 14.19 Mtext-related spacing features on the Properties palette.

The default Spacing Factor is 1.0, which sets the line spacing as a multiple of the single

line spacing. Single spacing is 1.666 times the text height in most cases. The Space

Distance value follows the factor value, but it shows the value as a true distance. For

example, text with a height of 0.20 has a default distance of 0.333 (0.20 × 1.666).

The combination of these two settings enables the mtext object to have a minimum

spacing while the Line Spacing Style is set to “At least.” If characters go above or below

the line, such as a [ or /, the lines adjust to maintain proper clearance. However, if you

need a specific line spacing, for a schedule perhaps, you can set the Style to Exact and

then the Spacing Distance to your desired setting.

Performing a Spelling Check
To check spelling within all your text-based objects, including attributes, issue the SPELL

command by choosing Spelling from the Tools pull-down menu. When you start the

command, AutoCAD prompts you to select the objects to check. If the SPELL command

encounters an unknown word, the Check Spelling dialog box appears, and you must

choose to replace the word, ignore the discrepancy, or add the word to your supple-

mental dictionary. If no errors are found, a message box appears, informing you that the

spell check is complete.
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Specifying the Dictionaries
The SPELL command looks up words in two dictionaries at any given time: a main dic-

tionary and a supplemental dictionary. Several main dictionaries are supplied with

AutoCAD; the default is the American English Dictionary. The default supplemental dic-

tionary is SAMPLE.CUS (it contains a number of AutoCAD command words and

terms). To change the dictionaries used by SPELL, issue the OPTIONS command. In the

Options dialog box, select the Files tab, then change the Main Dictionary and Custom

Dictionary File settings located under Text Editor, Dictionary, and Font File Names.

Unlike the supplemental dictionary, the main dictionary file cannot be modified or

added to. You can, however, add words to update the current supplemental dictionary.
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The SPELL command within AutoCAD 2005 can delve into all forms of annotation,
including blocks, to locate misspelled text-type items. It also displays misspellings in
xrefs but cannot correct them.

Creating a Supplemental Dictionary
A supplemental dictionary file is an ASCII-based text file that contains the additional

words you want SPELL to use when checking for correct spelling. The supplemental dic-

tionary contains one word per line. You can create as many supplemental dictionaries as

you want, but you can use only one at time. When you create a supplemental dictionary,

be sure to use a CUS filename extension.

Looking at Additional Text Options
This section covers several optional text handling features that may prove useful to you.

These features enable you to speed up the display of text, handle missing font files, and

insert text files into the current drawing.

Enabling the Quick Text Display
When AutoCAD opens or regenerates a drawing, if the drawing contains numerous text

objects, it can take quite some time to complete a selection process, especially if the text

uses complex fonts. If you want to speed up the process and do not need to actually see

the existing text, enable the Quick Text mode (QTEXT). To enable the Quick Text mode,

access the Display tab of the Options dialog box and select the Show Text Boundary
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Frame Only check box. When Quick Text is enabled, text-based objects are displayed as

simple rectangles that contain no characters. When you enable Quick Text mode, you

need issue a REGEN command to redisplay the text as simple rectangles.
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When Quick Text is enabled, new text objects are displayed as text characters while
the TEXT and MTEXT commands are active, which makes it easier to read what you
are typing.

Specifying an Alternate Font File
Font files are not stored with the drawing file. If a font file that is referenced in the draw-

ing is not available when the drawing is opened, an error message is displayed. You are

then prompted to choose a replacement font file. If you want to bypass all such error

messages, you can specify a font file that is automatically used whenever a needed font

file cannot be found. You specify this alternate font file in the Alternate Font File setting

under Text Editor, Dictionary, Font File Names in the Files tab of the Options dialog

box. The default alternate font is SIMPLEX.SHX.

I N S I D E R C A U T I O N

A couple of problems can occur when you use an alternate font. If the missing font
file contains special characters that the alternate font file does not have, the text on
the drawing may end up incomplete. Furthermore, because the space that a line of
text occupies depends on the font file used to generate the text, you may find that
when the alternate font is applied, the text on the drawing looks out of place or
does not fit properly.The best solution is to obtain the correct font files and use
them unless you are sure you have a suitable alternative font file.

Mapping Fonts
If you need to specify more than one alternate font file, use a font mapping file. A font

mapping file is an ASCII-based text file in which each line in the file specifies the font

filename to be replaced and its substitute font filename (separated by a semicolon). Note

that you should include the extension if there could be any ambiguity. The default font

map file is ACAD.FMP. You can identify a different font map file by changing the Font

Mapping File setting under Text Editor, Dictionary, Font File Names in the Files tab of

the Options dialog box.
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Adding Text as Attributes
An alternate method to adding text objects that are to be incorporated into block defin-

itions is to create attributes. Attributes behave much like text objects but have additional

functions beyond displaying text. Attributes are discussed in more detail in Chapter 10,

“Creating and Using Blocks.”

Dragging and Dropping Text Files
In Windows, you can drag a text file from the desktop or from Windows Explorer and

drop it into your drawing. AutoCAD automatically inserts the file as an mtext object,

using the current text settings for the text height, rotation angle, and text style.

Copying Text Using the Clipboard
You also can copy text from any application to your clipboard and paste the contents into

your drawing. If you use the PASTE command, the contents are dropped into your draw-

ing as an embedded object. If you use the PASTESPEC command, you can choose to paste

the clipboard contents as text, in which case the text is an mtext object.

The clipboard operations depend on OLE (Object Linking and Embedding). For more

information on AutoCAD’s OLE features, refer to Chapter 15, “Applications for OLE

Objects.”

Text Property Modification
AutoCAD 2005 includes a few commands to aid the process of changing text properties

such as height and justification. These new tools can help tasks that take hours to com-

plete finish in mere seconds. Learning these features and how to leverage them in your

everyday work is key to high productivity.

Scaling Text
Accessed through the Modify pull-down menu, Object, Text, the SCALETEXT command

enables you to select as many text objects as needed to modify. After selecting your

objects, you get a prompt

[Existing/Left/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR] <Existing>

where you can choose any number of methods to change the size of the text objects.
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If you choose the default <Existing> option, the base point for the scaling procedure is

based on the existing text insertion point. If you choose any other option, the scaling

process is relative to that justification type. For example, TC would change the scale of the

text relative to the Top Center of the text.

Following the choice of from where to scale the text, you get another prompt:

Specify new height or [Match object/Scale factor] <0.1000>

Here you decide how to change the size of the text. You can specify a literal size, pick an

object on-screen to get a distance, or just provide a scale factor such as 1.5. This changes

your text heights by 1.5 times. After that, the various text objects change.
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The SCALETEXT command has no dialog interface.

Changing Text Justifications
Also accessed in the Modify pull-down menu under Object, Text, the new JUSTIFYTEXT

command enables you to change the justification of multiple text objects very easily. You

could of course use the Properties palette, but that adjusts the justification only about

the insertion point. What this means is a piece of text that is left-justified at 0,0 when

switched to right justification will graphically move to a -X value but keep the insertion

at 0,0.

However, using the JUSTIFYTEXT command preserves all graphic locations of text and

relocates the insertion points. If you have ever had this problem, you will recognize what

a timesaver this is.

At the Select Objects prompt, gather all your text objects to change justification. Then

another prompt appears:

[Left/Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR] <TC>

Choose which justification type you want and then press Enter. AutoCAD then changes

the justification but doesn’t move the text’s first line visually. Of course, when you

change the justification on mtext objects, the subsequent lines of text in the mtext object

alter to honor the new justification.
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The JUSTIFYTEXT command has no dialog interface.

Space Translation
SPACETRANS is a transparent command available in AutoCAD 2005. This command con-

verts distances from space, such as model space, to an equivalent distance in paper space.

This is typically needed for determining text heights between spaces. The program is

transparent-capable, so it can provide the data to other commands.
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A transparent command is any program that can be used while running another
command.An example of this is the ZOOM command; you can zoom while drawing
lines in the LINE command.To use a transparent-aware command, prefix it with a ( ' )
sign and press Enter.

Summary
AutoCAD provides a variety of tools that deal with adding and editing text. This chap-

ter covered the various steps for creating and working with single lines of text in your

drawings, as well as how to add multiple paragraphs of text using the MTEXT command.

The chapter also provided detailed information on editing mtext and defining and

changing text styles to control the appearance of text.
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